
Mitchell 1 and ShopKey Management systems version 7.0  

 New Scheduler Application 

 Inventory Functionality 

 Using Tires (Settings, ATD Catalog, etc.) 

 Recent Changes! 

Brand new in version 7.0 is a completely re-engineered shop scheduler which allows you to manage every aspect of your shop. Appointments 
are now created using an existing customer and vehicle or you can opt to create new customers and vehicles during the scheduling process. 
Enhanced employee and technician setup, scheduled statuses, new scheduled resources, and a variety of calendar views give you total flexibility. 
Creating repair orders and estimates from appointments is easy, and receive appointment reminders to stay on top of your business. 

A new license plate lookup retrieves most of your vehicle details right from the Order screen. Vehicle lookup support is provided for most 
vehicles in the United States. Details such as the vehicle year, make, model, and VIN number are entered for you automatically. 

Changes since version 6.5.20 

 V 7.0.11 

o Tax Improvements 

 Support for Florida tiered tax calculation (configurable in Tax Rate setup) 

 Corrected discount rounding issue caused by part items with decimal quantities 

 Added 4 digits of decimal precision in Tax Setup 

o Updated Reports: 

 Sales Summary by Service Writer 

 Now includes invoices that had no parts/labor/sublet sales in R/O count and sales average. Previously, showed 

incorrectly in report under <None> 

 Updated report to include costs, minor format changes implemented to conserve paper 

 Inventory Sales Report - Cleaned up formatting to conserve paper 

o Corrected issue with deleting customers/vehicles with appointments 

 V 7.0.5 

o Scheduler Enhancements: 

 Window now remembers size/position/maximized state for each user 
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 Sched column in WIP as well as WIP Detail Dialog show correct schedule start date - if order is not yet scheduled, shows 

as blank 

 Added ability to right click in Sched column of WIP to either show WIP Detail Dialog, or open Appointment editor to edit 

schedule times 

 Added Scheduled Hours to Scheduler Appointment and Shop Event tab 

 'Sched Hours' uses your configured business hours, as well as holidays, to calculate how many actual shop hours 

each appointment uses. Matches value as in Appointment Editor. 

 Scheduling tab includes the total scheduled hours for the view you have selected. 

 Each Day/Week/Month breaks down the scheduled hours for that range (shows on same line as 'Appt' count). 

 Multi-day appointments will show hours each day based on start/end time and shop hours. 

 All day appointments use the full shop hours of each day it spans. 

 Appointment Count on Scheduling tab now includes appointments that started on previous days, but span across multiple 

days (Order Hrs only shows up on first day of appointment) 

 Built-in Appointment States now have preassigned colors 

 Custom Appointment States can define custom colors 

 State of appointment color shows up on Scheduling tab of Schedule and Appointment Editor 

 Improved performance of Schedule when loading/refreshing large appointment lists 

o Improved detection of Host Databases with incorrect versions when Manager starts - will now attemp to update workstation. 

o Fixed Invoice Validation of assigned Labor/Parts technician - correctly prompt when setting is turned on, and part/labor item has 

no assigned technician 

 V 7.0.3 

o Fixed Employee Editor - Phone Mask was causing error loading technicians 

o Fixed LOF & Symptoms not correctly selecting items 

o Fixed issues editing phone number on Customer Tab and Telephone Dialog 

o Handle purging estimates where there was an appointment for the estimate - appointment remains behind and can be deleted or 

updated 

o Improved follow-up appointment prompting when posting orders from the WIP 

o Changing vehicle ownership now prompts to select new tax settings (use customer's or vehicle's) 

o XCharge - Added support for configuring user name & password within Manager 

o Updated Report Invoice Hours 

 Corrected hazmat showing in totals 



 Increased font size in part and labor description 

o Updated Recommendation Dialog to make the Category drop down more apparent 

o Added Order Hours to Appointment Editor 

o Added Order Hours totals to Scheduler Views 

o Added Appointment end time rolling over to the next business day where those hours fit within the amount of Order hours (may 

span several days/weekends) 

o Appointment end time updated (incremented or decremented) when RO's Order Hours change 

 V 7.0.0 

o New & improved scheduler application 

 Calendar view with color coding helps you visualize upcoming work 
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 Calendar may be viewed by day, week or month 

 Resource view allows you to view calendar by technician or resource 

 Scheduled appointments link to a customer and vehicle 

 Canned jobs added to an appointment keep track of work needed 

 Creating orders from a schedule initializes order with canned jobs 

 Fully configurable with technicians, resources, employee holidays, and shop hours 

 Appointments tab displays events in a standard datatable view 

 Create shop events which are calendar events not related to work orders 

 Updated scheduled event report 

 Updated technician setup to include employee work hours 

 Auto schedule option schedules follow-up appointments when posting an order 

 Separate notes and sublet button on the order screen 

o Improved license plate lookup 

 Lookup vehicle properties based on license plate alone 

 Retrieve vehicle properties as well as VIN number 

o Ability to email Customer Vehicle Report from history tab and email history invoice detail 

o Correct marking a recommendation as printed 

o Customer lookup has separate first name and last name and configuration for number of results shown 

 V 6.6.10 

o Updated Reports 

 Updated Customer Vehicle Summary to show parts/labor information 

 Updated calculations IN the Posted Taxable Orders report 

o Improved the Vendor Sales History, graph is reflecting the last 12 months of Vendor items sold that appear on posted invoices 

o Improved Work In Progress saving of Columns 

o Improved the Confirming of parts process to be more efficient 

o Enhanced Profit Margin calculations on Purchase Orders 

 V 6.6.8 

o New Shop Hazmat setting to tax and treat Hazmat as Part or Labor 

o Revision tabs for the customer vehicle can now named by double clicking the revision tab text 

 Name is stored for all valid revisions 

 When revision is removed or cleared on transfer, the name is reverted to original name of SubEst1 and so on. 



 Empty revision cannot be named. 

o Can now Pay/Post Counter sale from WIP screen 

o Purchase Order Worksheets now show Margin of each item calculated from matrix 

o Part Item Edit dialog now has editable Margin field, setting a value there will update the user entered sale price to create the 

desired margin 

o Customer lookup is now even faster 

o Customer Screen Vehicle list now shows VIN number in grid; formatted for easily reading the last eight 

o Invoice and Counter Sale screen now include 'Balance-at-a-glance'; two additional columns in the totals section displaying: 

 'Deposits' - not visible until a payment is made 

 'Inv. Bal.' - Invoice Balance due 

o Added new setting for checking only for matching part numbers when transferring from a catalog (not enabled by default) 

 Find setting at Shop Data -> Default Settings -> 'Check for Substitute part(s) when transferring from catalogs' 

 When enabled, transferring parts from a catalog looks for a part# match against inventory, and when multiples are found, 

the substitute parts dialog is displayed to resolve against inventory. 

 When selecting an alternate part that does not have enough on hand qty, two lines items will be created to allow for 

ordering the remaining qty 

 When not enabled, behavior remains as before 

o Added ability to recover a customer mistakingly deleted (Configuration -> Special Maintenance -> Recover Deleted Customers) 

o Inventory Search limit is now user configurable (defaults to 1000): Value can be set from 50 to 5000. 

o Improved focus cues (for keyboard navigation) to User Interface controls on customer, vehicle, and order tabs 

o Scroll bars added to Status/Location setup screen 

o Updated Reports 

 Invoice reports show Hazmat on left or right side depending on Tax as labor/part setting 

 Committed parts reports fixed to no longer cause divide by zero error 

 Accounting reports standardized with '*** No Cust Name***' for counter sales with no customer 

 Accounting reports now handle maximum length of first, last, and/or company name 

 Florida Invoice from history will correctly show 'Invoice from history' 

 Florida invoice correctly displays balance due when using tire fees 

 INV Stock Paper report: Taxes will not be broken out unless there are more than one 

 Sales Summary Monthly report fixed to handle large totals 

 Low Inventory Report updated to include 'Location' field 



 Tech Hours report now calculates average effective hours correctly 

 Service Writer Posted Order Report: 

 Show Service Writer's effective labor rate 

 Sublet no longer included in labor total (has its own column, and shown in total column) 

 Report is in landscape 

 Wisconsin Invoice Reports: 

 New "INV w/o Hrs/Part # (WI)" 

 Revision disclaimers included 

 Tech Hours Report - fixed issue with formula calculating average effective hours 

o Order screen title bar highlites the last eight digits of VIN number 

o Updated inventory committed part to always stay in sync with open order committed parts 

o The vehicle list on the Customer screen now shows last in date and mileage in 

o Sales history dialog for vendors and inventory items updated with cleaner looking graph 

o Usage of "Update Account Info" standardized to "Update Customer Status" in the application 

o Line item sequence on revisions is maintained when selling a revision to an order 

o Behavior of pasting labor line item matches 5.9 and retains customer type when the 'Non standard Labor rate' has been checked 

o Changing Price Markup Matrix no longer overrides user entered prices in canned jobs or promos 

o Tire fees are no longer affected when discounts are applied to the order 

o Fixed 'Red Flagging' Status items in WIP, items will now red flag properly after WIP refreshes 

o 'No Commission' checkbox no longer checks automatically when creating a new inventory record when receiving a part from a PO 

 V 6.5.57 

o Updated Canned Jobs Dialog: 

 Now able to transfer multiple canned jobs to order using Ctrl + Left Mouse Click, or by checking check boxes, or using 

keyboard (shift + arrow keys) 

 Items selected remain selected until manually unselected (clearing or searching again will not unselect items) 

 Dialog is now resizable 

 Grid column headers are now click-able to change sorted field (and sort direction) 

o Database Restore Utility will now update DMV version of database after backup restored 

o Transferring items from Catalogs (Estimator, P.O.s) no longer matches parts based on the size (prevents issues finding an 

Inventory item if the size text was changed) 

o Handle rounding when multiple taxes applied to order 



o Corrected order total sometimes rounding off by one cent in reports 

o Report Changes: 

 Updated Tech Hours report new column 'Effective' displays the effective rate per labor, technician effective labor rate, and 

overall effective labor rate 

 Updated Taxable Order by Tax Category Report to handle large databases without timing out 

 V 6.5.56 

o Improved error handling when launching Manager: 

 If host database is not reachable when starting application, will now show a helpful error message indicating the 

connection problem. 

 The refresh button will try to re-establish the connection; otherwise, there is also the ability to change your Host/Database 

(in the case the host name may have changed) 

o Using 3 digits of precision for technician rate calculations 

o Expanded maximum amount of catalog buttons available for use to 15 

o Report Improvements: 

 Tech Pay Hours report will now show all technicians correctly when Repair Orders, having vehicles with multiple custom 

attributes, are present 

 Improved speed of generating Customer Email by Last Name Report (should no longer time out on slow hosts) 

 Added new report: Est w/o Hrs-Part No 

 Removed overlapping text on Florida Inv with Hours/No Rev Data report 

 Fixed issue with some invoice reports incorrectly showing a $.01 balance due 

 Removed duplicated labor lines from Tech Worksheet 

o Added new Setup option to hide estimates from Schedule (Setup -> Screen View -> 'Show Estimates in Schedule') 

o Order Grid Now includes 'Size' column 

o Deleting an Inventory items behaves as expected, removing it from parts inventory 

o Handle negative quantities correctly when editing a part on order 

 The committed quantity decrements correctly when posting invoices 

 The quantity on-hand for inventory parts increments with negative quantities 

o New (blank) orders, no longer switch vehicle when viewing Historical orders and going back to order tab 

o History Search, invoice tab now has a posted date filter for locating history by date 

 Optionally, the date filter search may be saved for the next time history search opens 
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 V 6.5.54 

o When transferring parts from a catalog, Account Class of matching Inventory Parts will now be retained 

o Find History Screen Updated: 

 Returned number of Invoices increased to 250 (previously was 100); now returns the latest invoices by Posted Date 

(previously using Printed Date) 

 Grids updated to be sortable on multiple columns 

 Added a YMM column to the history grid to identify the car the invoice was for 

o Customer Email Improvements: 

 Email field length increased to 180 characters (previously was 50) 

 Multiple email addresses can be entered (separate emails with a semicolon) 

 If multiple addresses are stored, they will each get sent to the mail client when clicking 'Email' 
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o Corrected Memory issue when viewing many reports (which could lead to an out of memory situation over time) 

o Now able to configure Web and Email Address in Shop Settings 

o No longer showing duplicates in Order Pick List for all orders 

o Added a Manual Check for Updates Menu Entry (Security Area - Special Maintenance): Help -> Check For Updates 

o Preserve Estimate Totals when converting a Special Order to a Repair Order to an Invoice 

o Improved Follow Up Report menu: 

 When deleting a customer from search result list, now put the selected focus on the item above (no longer jumps to top of 

list) 

 When deleting one vehicle from the search results list, of a customer with multiple vehicles, the entire customer is no 

longer removed 

o Improved Report Printing (direct to printer): 

 Selects the proper printer paper source (based on selected printer settings) 

 Collates the printed pages when multiple copies are printed 

o Report Improvements: 

 Invoice Hours Report: Correctly showing heading on each page, Handle Invoice numbers greater than 9,999.99, Hazmat 

now back in labor total, Totals box now prints only if tire fee is present - re-ordered lines (Labor, Parts, Sublet, Tire Fees, 

Discount, Sub Tax, Total, Balance) 

 Invoice Hours No Rev data: Part numbers show on report, Balance Due field displays only 2 digits after dot 

 Repair Order Detail: Now showing scheduled date and increased font size of totals area 

 Cash Receipt: Changed 'Report Data' to 'Print Date', Now room for name (will print name or company is exists), Better 

alignment of totals and currency symbol 

 Coupon Utilization Reports: Changed title from 'Discount ID' to 'Coupon ID', subtitle is now 'Discount Name:' 

 Vehicle Reports by Makes now displays custom vehicles 

 Expanded Sheet includes tire fees/size 

 Wisconsin Estimate no longer overlaps labor and recommendation 

 Posted Totals Invoice report: Added tire fee columns (if fees exist), added tire fee total (if fees > 0), added tax total to 

grand totals 

o Batch Payments now add overpayment to Customer Credit instead of On Account Balance when clicking apply multiple times 

 Prior release Documents can be found at Mitchell1.com 

New Scheduler Application 

http://mitchell1.com/knowledgebase/article.php?id=808


This latest version of your shop management software includes a new scheduler application which provides a sophisticated calendar view. 
Events are linked to a customer and a vehicle and canned jobs can be added to the order. Appointments can be dragged and extended just by 
using your mouse. Technicians and resources can be defined and then allocated to appointments and reminder popups will alert you to 
upcoming schedule events. 

From a scheduled appointment, you can easily create a new work order or estimate. The scheduled item properties are copied into the new 
appointment and all of the canned jobs will be created for you. A link between the schedule and the work order allows you to jump from the 
scheduled event to the work order. New schedule events can be created from the WiP screen, the WiP detail dialog, or the work order by going 
to Options and then Appointment. 

The calendar allows you many different views including a day view, week view, or month view. Alternate views include a technician view which 
quickly indicate the availability of your technicians and the resource view which does the same for resources. A print preview button allows you 
to print your calendar view. 

Within the scheduler, two additional tabs allow you to take more control of your scheduler. The Appointments tab shows a data table view of 
appointment. Each column of the table is sortable and you can search data in the table by right clicking on the column headers. The Shop Events 
tab displays a data table with only the shop events. Shop Events are schedule items which are not associated with a customer or vehicle. Use 
shop events for things like holidays, special events, or practically anything that involves your shop. 

Inventory Functionality 
Part records will now have additional fields for each part: Size Field and Tire Checkbox. A size field has been added which is used to calculate tire 
fees if applicable, the size field can also be used for nuts, bolts, hoses, or anything you would like the size to appear on the customer’s estimates 
and invoices. The size field is immediately below the Description field. If you are migrating from a previous version of ManagerPlus or ShopKey 
Professional, you will want to update the size field for any tire records previously created. 



 

  

Configuring tire functionality 

The tire functionality was developed to include a separate price matrix for tires, automatic income categorization for each tire sold, automatic 
calculation, application of tire fees and the ATD catalog to look up tires & wheels. Setting this up in your system is easy by following the steps 
below. 

Income Accounts 

1.    Click on the "Setup" button found of the main toolbar   

2.    Click on the "Standard Tables" button, then select "Income/Payment Types" 



a.    Create a new income account and name it appropriately; we suggest "Tire Fees" 

Default Category 

3.    Click on the "Standard Descriptions" button, then select "Category"             

a.    If needed, create a category for Tires 

Tire Matrix and Fees 

4.    Click on the "Standard Tables" button, then select "Tire Matrix" 

This new markup matrix applies only to those parts marked as tires. Similar to our parts matrix, this tire matrix allows you to progressively 
scale your tires markups according to what you paid for each tire rather than a single markup percentage applied to all tires purchased. We 
recommended using several levels to remain profitable and competitive where it really counts. 

You have the capability of keying the parts Markup matrix off the Last Cost or Average cost of the tire inventory. Last or Average Cost is 
significant because it this will influence where parts land on the matrix and also parts profit figures on reports will read differently depending on 
which method is selected here. Average cost data is maintained as long as the part quantity on hand remains above zero. Changes made to the 
tire Markup matrix are applied by clicking on Apply Matrix to tire Inventory. This will display a dialog box stating how many records will now use 
the new Markup percentages. This dialog also allows you to set the default category assigned to tires for accurate reporting. 

5.    Click on the "Standard Tables" button, then select "Income/Payment Types" 

a.    Configure the matrix to your requirements, set the "Default Tire Category" and click on the "Apply to Tires" button. 



 

  

Setting up tire Fees 

6.    Click on the "Tire Fees" button to continue. The Tire Fees screen 

a.    Configure fees to conform to local, state, federal or any other regulation. The example above shows the use of conditional 
fees. In this example, tires with a diameter less than 20 inches will be assessed a fee of 2% of the cost. Tires equal to or greater 
than 20 inches in diameter, are assessed a fee of 1% of the cost. 



 

  

Configuring the ATD catalog 

To use the ATD catalog you must first obtain catalog credentials from ATD. You may send an email to them requesting an account number. Make 
certain you include your Shop Name, Contact Name, Address, phone and you current ATD account number if you have one. Their email is ATD 
OnLine Support. The next step is turn on the catalog and setup and configure a vendor record to associate the catalog to. Whether you use your 
existing ATD vendor record, or create a new one, this vendor record will include the name of the vendor, address, phone, email address and 
catalog credentials. With credentials in hand, let's get started! 

7.    Click on "Configurations" at the top left of the screen, then select "Special Maintenance" then "Toggle Catalog Availability". Turn the 
ADT catalog on and click the "Save" button.   Select "Configurations' again then move the mouse over Vendor Setup and click once. 
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a.    Click on the "Add"  button to create a new vendor record, fill the record in with pertinent information. Note: You may click 
on the `Account Class' button, then click on "Income/Payment Types" to add a specific income account for Tire Sales. 

8.    Click on the "Setup Link" button, Click on the `Add' button to create a new vendor record, fill the record in with pertinent 
information. Note: You may click on the "Account Class" button then click on the "Income/Payment Types' tab. Add a new income 
account for `Tire Sales' if desired. 

a.    Click on the "Setup Link" button, select "Setup ATD Link", then enter credentials provided by ATD. 

T 

  

The tire functionality and catalog is now ready to use from within any Estimate, Repair Order, Counter Sale, Invoice and Revisions. 



 


